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edge, require using the PICmicro microcontroller in a manner outside the operating specifications contained in the data sheet. 
The person doing so may be engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 
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M KEELOQ® EVALUATION KIT
II USER’S GUIDE

1.0 INTRODUCTION

The KEELOQ® Evaluation Kit II provides the opportunity
to evaluate KEELOQ Code Hopping Technology quickly
and easily without having to make a large capital
investment. The evaluation kit contains all the hard-
ware and software necessary to implement a fully func-
tional remote control system and demonstrate all
operating modes of the following devices:

• HCS101, HCS200, HCS201, HCS300, HCS301, 
HCS320, HCS360, HCS361, HCS362, HCS365 
and HCS370 encoders

• SIMPLE (AN663/AN659), NORMAL (AN661/
AN642), SECURE (AN662/AN652) Software 
Decoders and related Application Notes

• HCS500 (8-pin), HCS512 (18-pin) and HCS515 
(14-pin) Decoders

The kit can also be used to program and demonstrate
the Encoder functionality of the HCS410, HCS412 and
HCS473 transponders (trans-coders).

The included Windows-based software can be used
to program the demonstration transmitters and the DIP
samples provided in the sample kit.  Encryption keys,
configuration information and other user selectable
information are automatically programmed into the
encoder’s EEPROM. Although many interdependent
parameters must be taken into account when program-
ming the encoder and decoder combination, the pro-
cess is automated and transparent to the user.

1.1 Evaluation Kit Contents

The KEELOQ Evaluation Kit contains the following hard-
ware, software and documentation:

• Programmer and Decoder Demonstration Board
• Two Demo KEELOQ Transmitter Boards

• KEELOQ Secure Data Product CD-ROM 
• Sample Kit containing various KEELOQ encoder 

and decoder samples

The KEELOQ Secure Data Product CD-ROM contains:

• All KEELOQ Devices data sheets
• All KEELOQ, Security related Application Notes

• All KEELOQ Related Software Tools, including:
-  the Windows GUI software for the Evaluation 

Kit II
- MPLAB - PRO MATE II support software for 

KEELOQ 
• This User’s Guide (DS41155)
• Multiple introductory KEELOQ presentations and 

Training material

A Separate Accessory Kit (AC162048) can be 
purchased providing:

• Power Supply Unit (100 – 240V input, 9V output)
• RS-232 Cable

About the KEELOQ® Evaluation Kit II
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2.0 INSTALLATION

The software provided on the disk is based on the Win-
dows operating system. The KEELOQ Evaluation Kit II
software can be installed either in the default
C:\HCS_EVAL directory or in another directory of
choice.

1. Insert the KEELOQ Secure Data Products CD-
ROM into the CD drive (in the following we will
refer to it as drive D).

2. If you are using Windows® 3.1, from the Pro-
gram Manager File > Run command, type
D:\tools\HCS_EVAL\SETUP. 
If you are using Windows 95, 98 or Windows
NT® 4.0, click on the Start button, select Run
and type D:\tools\HCS_EVAL\SETUP. 
The Setup screen will appear requesting to con-
firm the installation.
Click OK to continue, or Cancel to abort the
installation.

3. The Setup program will then display the “Select
Destination” dialog box.  
Click OK after selecting where the software is to
be installed or click Cancel to abort the installa-
tion.

4. The “Make Backups?” dialog box will appear.
Click Yes to backup files being replaced.
Click No to overwrite files without backup.
Click Cancel to abort the installation.

5. If Yes was selected in the previous step the “The
Select Backup Directory” dialog box appears.
Click OK after selecting a directory where 
backups will be stored.
Click Cancel to abort the installation.

6. After the files have been installed the “Install
Icons” dialog box appears
Click Yes to add the software Icons.
Click No to skip adding the Icons.
Click Cancel to abort installation.

7. After the software has been successfully
installed, a “Setup Complete” message will
appear.

2.1 Serial Port Selection

The KEELOQ software uses a serial port to communi-
cate with the programmer board. The active serial port
defaults to COM1 but can be changed  in the    “Com
Port”    dialog     box (Figure 2-1). The dialog box is dis-
played by selecting “Com Port” from the “Options”
menu.

FIGURE 2-1: SERIAL PORT SELECTION DIALOG BOX

Installing KEELOQ® Evaluation Kit II

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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Test the selected serial port by connecting the pro-
grammer board to the appropriate COM port, power the
programmer board and press the “Test” button. The
software will display a message indicating whether the
programmer has been found or not.

2.2 Checking Windows Software and 
Installed Firmware Versions

The Windows Graphical User Interface (GUI) software
version and the programmer/receiver demo board firm-
ware version may be verified from the main menu:
Help-> About.   The programmer/receiver demo board
must be powered (with a 9V battery or an external
power supply) and connected to the computer’s serial
port for the firmware verification.

FIGURE 2-2:      THE ABOUT DIALOG BOX .

The About command in fact exercises the currently
selected serial port (or the default one) and verifies the
programmer/receiver board’s presence.

If a board is not found or is not powered at the time of
the test, an error message will be displayed in place of
the firmware version numbers.

The two version numbers most probably will differ as
new firmware and software revisions will be released to
improve or add support for new devices and features.

Windows

GUI code

Firmware 
installed
PIC16F877
code

installed
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3.0 THE GRAPHICAL USER 

INTERFACE

The Evaluation Kit II’s new Graphical User Interface
(GUI) is centered around a simple paradigm.  The user
creates a Project by assembling encoder blocks (up to
four) and decoder blocks (up to four) in the project win-
dow and then visually defines their relationship.

Figure 3-1 shows an example configuration screen
shot.  The user is defining a system composed of two
encoders; an HCS365 Advanced Dual Encoder and an
HCS473 3-axis transcoder. There are also two decod-
ers: (1) an HCS515 Integrated 14-pin Decoder and (2)
a Custom defined Transponder Reader.

The Links, represented graphically as arrows, illustrate
how the various encoders are bound to the HCS515
decoder (currently configured for Normal Learn). The
encoders will therefore be programmed with both a
matching Key Generation Algorithm (Normal Learn)
and a matching Manufacturer Code (in this case, the
default value: 0123456789ABCDEF HEX).

The transponder portion of the HCS473 is linked,
instead, to the custom defined Transponder Reader so
the Key used for Authentication (IFF) will match both
the Key Generation Algorithm (Simple Learn in this
case) and the Reader’s Manufacturers Code ( in this
example, the value FEDCBA9876543210 HEX).

FIGURE 3-1: THE EVALUATION KIT II GUI  

3.0.1 CREATING A NEW PROJECT

The user will typically create a new project using the
File->New Project menu. A prompt will confirm the
intention to erase any components of the previous
project and start from scratch with an empty project
window.

Links Project configuration file

Encoders List Decoders List

Encoder

Block
Decoder
Block

Evaluation Kit II GUI Software

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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FIGURE 3-2: THE FILE NEW PROJECT MENU  

3.0.2 ADDING NEW ENCODERS AND 
DECODERS

Select the Edit->New->Encoder or the Edit->New-
>Decoder command (see Figure 3-3)  from the main
menu to add an encoder or decoder block to the current 
project.  Keyboard “E” or “D”, respectively, may be used
as shortcuts.  (refer also to Figure 3-1 for the encoder
and decoder list aspect).

FIGURE 3-3: ADDING ENCODERS AND DECODERS TO A PROJECT  

The program will immediately display a New Encoder
or Decoder Dialog Box (see Figure 3-4 and Figure 3-5)
allowing the user to select a desired model.

The device selection dialog boxes show lists of avail-
able and supported models to choose from.  One of the
many distinguishing characteristics of each device is
indicated: HCS301 operating voltage, HCS201’s
adjustable internal oscillator and HCS473 three-axis
transponder.    
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FIGURE 3-4: THE NEW ENCODER DIALOG BOX 

FIGURE 3-5: THE NEW DECODER DIALOG BOX 

3.0.3 SELECTING AND DELETING AN 
ENCODER OR DECODER

Using the mouse, click on any encoder/decoder block
to select it; its “selected” graphical block representation
will change to a red border (see Figure 3-6).  The key-
board arrow up and arrow down keys change the selec-
tion to adjacent encoders or decoders in the same list.
The keyboard arrow left and arrow right keys will switch
between the lists.

Hitting the DELETE (DEL) key or selecting the Edit-
>Delete function from the main menu removes the
selected block from the project window.  A dialog box
will pop-up asking to confirm the operation before the
actual deletion.

Software

Decoders

Custom

Decoder
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FIGURE 3-6:  THE SELECTED ENCODER/DECODER    

3.0.4 ENCODER AND DECODER 
CONFIGURATION

A selected Encoder/Decoder block may be configured 
by either pressing the ENTER key, double clicking with 
the mouse or by selecting the Edit->Configure option 
from the main menu.

The type and model of the currently selected device 
determines what Configuration Dialog Box aspects will 
immediately open.

Software decoders, based on their respective 
Application Note’s source code, are the only devices 
that cannot be configured; their parameters are 
defined in firmware.  To change software decoder 
parameters one must modify the source code, re-
assemble it and program new samples (using a 
PICSTART Plus or a PRO MATE II Universal 
Programmer).

FIGURE 3-7: THE SOFTWARE DECODERS WARNING MESSAGE 

3.0.5 DEFINING CUSTOM DECODERS

A user may wish to define a decoder component
derived from Application Note software or other Cus-
tom Code developed to fulfill a requirement no existing
decoder could.  A Manchester reception based
decoder using a 40-pin PIC16F77 FLASH microcon-
troller, for example.

Such a Custom decoder is but one device in a larger
project.  Definition of both its Learning Method and
Manufacturer Code is essential when programming the
linked encoders.  For this reason, the last option in the
New Decoder Dialog Box (Figure 3-5) allows the defini-
tion of such a Custom Decoder.  

Selected

Decoder
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FIGURE 3-8: CUSTOM DECODER CONFIGURATION  

Figure 3-8 shows what information to specify in defin-
ing a Custom Decoder.

The Description field allows a “name” or brief textual
description be assigned to the decoder documenting its
role in the project.  The Description may be up to 16
characters.

Perhaps something like “Manch - PIC16F77”,
“MyCode rev. 2.5” or any text string significant to the
project. 

The importance of this Description field will be more
clear later when analyzing Encoder Configuration and
Linking.

The Manufacturer Code is simply a 16-digit hex num-
ber    (64-bit)   that   defines  the Key  unique  to   this
Manufacturer/Project. 

The Learning Method specifies what scheme will be
used to derive the Encryption and Decryption keys
unique to each Encoder in the Project.

Finally, the Transponder Reader check-box helps the
Evaluation Kit software graphically represent the
decoder.  No standard readers exist for KEELOQ Tran-
sponders like the HCS410, HCS412 and HCS473.
Their base station, or Reader, must be a custom design
(perhaps derived from an Application Note) and it must
be represented as such in the Project.  Based on cus-
tom software, the only means of configuring such
devices is by changing source code, re-assembling it
and programming a new PICmicro® microcontroller
(MCU) using a standard Microchip programmer like a
PICSTART Plus or a PRO MATE II.   
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3.0.5.1 HCS512 Configuration and 
Programming

If the selected decoder block is an HCS512, the corre-
sponding Configuration Dialog Box will allow the user
to configure:

• Description
• Manufacturer Code
• Learning Method

• Enable/Disable the Sleep Mode

An HCS512 DIP sample must be installed in the appro-
priate Main Board socket to complete the device pro-
gramming attempt.

Pressing the “Program Mode” button will first result in
an internal evaluation of the various configuration val-
ues.  The input fields will then be disabled, grayed-out,
safely freezing the configuration for the following pro-
gramming step.  The “Program Mode” button will reflect
this state by changing its caption to “Program”.  Subse-
quent button activations will now perform the actual
programming attempts.

Failure, success or any serial communication error will
be reported on the status line.

FIGURE 3-9: PROGRAMMING THE HCS512 

3.0.5.2 HCS515 Configuration and 
Programming

If the selected decoder block is an HCS515, the corre-
sponding Configuration Dialog Box will allow the user
to configure:

• Description

• Manufacturer Code
• Learning Method
• Enable/Disable the Repeat Mode

An HCS515 DIP sample must be installed in the appro-
priate Main Board socket to complete the device pro-
gramming attempt.

Pressing the “Program Mode” button will first result in
an internal evaluation of the various configuration val-
ues.  The input fields will then be disabled, grayed-out,
safely freezing the configuration for the following pro-
gramming step.  The “Program Mode” button will reflect
this state by changing its caption to “Program”.  Subse-
quent button activations will now perform the actual
programming attempts.

Failure, success, or any serial communication error will
be reported on the status line.

Status line
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FIGURE 3-10: HCS515 DECODER CONFIGURATION DIALOG BOX 

3.0.5.3 HCS500 Configuration and 
Programming

The HCS500 decoder promises to be obsoleted by the
newer HCS515 model. The Evaluation Kit II Main
Board therefore requires minor hardware modifications
to support the device.  The required modifications are
detailed in Appendix C.

If the selected decoder block is an HCS500, the corre-
sponding Configuration Dialog Box will allow the user
to configure:

• Description
• Manufacturer Code

• Learning Method
• Enable/Disable the Repeat Mode

An HCS500 DIP sample and companion 24LC0X
eeprom must be installed in the appropriately modified
Main Board to complete the device programming
attempt.

Pressing the “Program Mode” button will first result in
an internal evaluation of the various configuration val-
ues.  The input fields will then be disabled, grayed-out,
safely freezing the configuration for the following pro-
gramming step.  The “Program Mode” button will reflect
this state by changing its caption to “Program”.  Subse-
quent button activations will now perform the actual
programming attempts.

Failure, success or any serial communication error will
be reported on the status line.

FIGURE 3-11: HCS500 DECODER CONFIGURATION DIALOG BOX 

Note: When programmed, the HCS500
saves the configuration data in the
companion 24LC0X memory.
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3.0.6 ENCODER CONFIGURATION AND 
PROGRAMMING

Opening a selected Encoder or Trans-coder model
allows the user to view and edit its functional parame-
ters.

FIGURE 3-12: AN EXAMPLE ENCODER CONFIGURATION DIALOG BOX  

While the number and type of configurable parameters
vary from model to model, all dialog boxes share a sim-
ilar template.

The Decoder field Links the Encoder to a particular
decoder; the decoder which the encoder must be com-
patible with.

The Serial Number field displays the most recently
assigned encoder serial number in the current project.

There are several Format configuration options;
Baud Rate (speed) selection field, Modulation format
(PWM, Manchester) and Low Voltage Trip Point Select.
The number of options varies with the selected
Encoder model.

Several Check Boxes to enable and disable various
feature like a Start Pulse or a Minimum number of Code
Words per transmission

The standard Status line to communicate success
and/or Failure of a Programming attempt.

Several Control Buttons:

• “Program Mode” freezes the current configura-
tion. The button then changes to a “Program” 
button for subsequent programming attempts.

• “Default Values” restores a predetermined safe 
configuration (including grayed out advanced 
options).

• “Advanced Mode” enables additional input/
configuration fields that are otherwise disabled 
and grayed-out.  The button is present only in 
complex encoder models and gives the user 
access to the most complete set of configuration 
options available for the part.

• “Close” will register any configuration changes 
and close the dialog box.

• “Help” gives access to a help page relative to the 
selected part.

As previously mentioned, Encoder DIP samples may
be programmed either by placing them in the appropri-
ate Programming Socket or by “In-Circuit Programing”,
if mounted on a demo transmitter connected to the
Transmitter Programming Connector.

Serial Number

Format config.

Check boxes

Status line

Control Buttons

Linked Decoder

Note: At least one decoder must be defined
in the project before an encoder can be
programmed. 
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3.0.7 ADVANCED ENCODER OPTIONS

A great number of configurable parameters exist in
some more complex devices like the HCS365 and
HCS370.  The user is initially offered the option of edit-
ing only a part of them.  The remaining options are still
visible but the input fields are grayed-out indicating
they are disabled.  Modifying these advanced options
will typically result in encoders being programmed with
configurations incompatible with the evaluation kit’s
standard decoders. 

The user can enable/disable the Advanced Options by
selecting Options>Advanced Options on the main
menu before opening an Encoder Configuration Dialog
Box. The same result can be obtained by pressing the
“Advanced Mode” button inside an Encoder Configura-
tion Dialog Box.  The button’s caption changes to “Nor-
mal Mode” allowing the user to disable the advanced
option input when finished.  In general, these options
should only be modified by users already familiar with
KEELOQ encoders and decoders.

FIGURE 3-13: ADVANCED OPTIONS

3.0.8 SAVING A PROJECT

The File->Save Project and File->Save As options
can be selected from the main menu to save the
project’s current status.  Current status includes:

• the list of Encoders, and for every Encoder: 
- the full Encoder Configuration (including last 

Serial Number value)
• the list of Decoders and for every Decoder:

- the full Decoder Configuration

The project file is saved with the assigned name and
extension to the selected directory.  Although the “.cfg”
extension is suggested, any extension will suffice.  The
last project’s configuration file is always remembered
by the Evaluation Kit II software and automatically
loaded at the next launch of the program.

3.0.9 LOADING A PROJECT

Similarly, selecting File->Load Project from the main
menu allows the re-load of a previously saved Project
(configuration file).

The user is warned that in doing so the current Project
configuration is lost.

3.0.10 PRINTING A PROJECT 
CONFIGURATION FILE

Project configuration files are simply ASCII text files
built using Microsoft Windows Private Profile functions.

Their content is organized in sections separated by
section headers (like [Encoder 1]) and every section
has item-value pairs used to store the unique configu-
ration parameters values (like Seed_Type = 1).

As a result, a configuration file can be loaded using
Notepad or any Text Editing program and then printed,
e-mailed or faxed for documentation or support pur-
poses. 

Advanced
Options

Advanced Mode button

Note: The user is recommended not to edit
the configuration file contents by hand
since this could lead to unexpected
results when the Evaluation Kit II GUI
Software re-loads the project.   
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4.0 DESCRIPTION

The radio receiver module on the Main Board is con-
nected to all three demonstration decoder sockets as
well as to the main processor (PIC16F877).

The GUI software monitors the Evaluation Kit’s radio
receiver data by selecting the Tools->Monitor Radio
option from the main menu. A Radio Transmission
Monitor dialog box will appear and the GUI software will
begin polling the Main Board for new transmissions at
regular 1/second intervals. The GUI software receives
notification of each new transmission, updates the
Hopping code and Fixed code fields appropriately and
reproduces an oscilloscope-like waveform display for
demonstration purposes.

The initial firmware and software release (rev.3.00)
supports only PWM modulation format and a limited
subset of Baud Rates (200 – 400 µs TE).  Attempting to
Monitor transmissions from encoders configured for
higher or lower Baud Rates or different modulation for-
mats will fail, resulting in the transmission being
ignored.

FIGURE 4-1: THE RADIO TRANSMISSION MONITOR DIALOG BOX

2 4 1234567A36FC5DD

waveform
monitor

Serial Number

Function Code
Status Hopping code

Monitoring KEELOQ® Transmissions

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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4.1 Receiving KEELOQ Transmissions

All Encoder models share a common code word format
composed of:

• 32-bit Hopping Code portion containing the 
encrypted sychronization information

• 28-bit Serial Number that is the unique transmitter 
identifier

• 4-bit Function Code indicating what button(s) 
activated the transmitter.  The Function Code is 
sometimes combined with the serial number 
creating a single 32-bit Extended Serial Number

• 1 Low Voltage indication bit communicating to the 
decoder the transmitter battery status

• 1 to 5, additional status bits depending on the 
encoder model.

The Evaluation Kit II firmware attempts to receive only
the first 66 bits of any radio transmission. The GUI soft-
ware separates this data into the appropriate dialog
box fields after a successful reception.

The example in Figure 4-1 shows that:

• The Hopping Code received is A36FC5DD 16

• The transmitter Serial Number is 123456716

• The Function Code transmitted is 4 (S1 activated 
on the transmitter)

• Status bits are 0 and 1 respectively. Assuming 
the encoder used was an HCS300 they can be 
interpreted as: 
- Low Voltage = 0 

- Repeat = 1

4.2 Troubleshooting

PROBLEM:

The GUI software is unable to initialize the Main Board
and a Serial Communication Error message is dis-
played.

SOLUTIONS:

1. Check that the RS-232 cable between the PC
and main board is in place.

2. Check that the Main Board is powered 
appropriately.

3. Check that the correct serial port has been
selected. 

4. Reset the main board.

PROBLEM:

No transmissions are received:

SOLUTIONS:

1. Check that the connection between the decoder
and main board is correct.

2. Check that the RS-232 cable between the main
board and PC is in place.

3. Check that the JP1 jumper on the main board is
in place.

4. Check that the link JP1 on the Demo Transmitter
board is in place.
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5.0 GENERAL DESCRIPTION

Microchip KEELOQ Code Hopping encoders are
intended for secure authentication and remote control
applications. 

The encoders contain internal non-volatile memory
(EEPROM) for data and configuration storage. They
will retain information for several years, even when
stored without power supply. 

Minimal external components are required to imple-
ment a complete remote transmitter.  All input pull down
resistors, oscillator circuit components, voltage regula-
tion, LED driving, voltage sensing and button debounc-
ing circuits are integrated in the KEELOQ encoder
silicon.

FIGURE 5-1: TYPICAL KEELOQ TRANSMITTER

In addition to the IC, all that is required is a circuit for
transmitting the information over the desired media
(e.g., a UHF radio transmitter), a battery, and a button
switch as shown in Figure 5-1. A single encoder can
command a multifunction decoder to activate up to 15
specific functions/outputs. The user would select the
desired function pressing one or more buttons on the
transmitter.

For a complete list of all the features of the various
KEELOQ encoders and a  description of their features,
consult the related data sheets included in the
CD ROM or download them from the Microchip web
site: http:\\www.microchip.com. 

A brief summary of basic encoder features is given in
Table 5-1.

5.1 Encoder Features

5.1.1 ENCODER SYNCHRONIZATION

Every KEELOQ encoder has at least a 16-bit synchroni-
zation counter that is incremented each time the
encoder is activated. The counter is encrypted and
transmitted as part of a code hopping transmission.
When decoder learns a transmitter, the encoder’s
received serial number, calculated encryption key and
decrypted synchronization information are stored in
EEPROM. It is then very easy for a decoder to check
whether a given transmission is a valid transmission or
a transmission re-transmitted by a code grabber.  The
received counter value must be greater than the stored
synchronization counter value for a transmission to be
valid.

HCS3XX

RF Circuitry

3 to 12V 
battery*

VDD

S3

S2

S1

S0

LED

DATA

VSS

(*Note: depending on actual encoder model) 

KEELOQ® Encoders

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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In addition, provisions must be made for counter dis-
crepancies caused by a user activating the transmitter
while out of range of the decoder. KEELOQ decoders
accommodate this by providing two synchronization
windows. If the synchronization counter received is 1 to
16 counts above the stored counter, the decoder
accepts the transmission as a valid transmission,
updates the stored counter and activates the appropri-
ate output. If the synchronization counter received is
between 16 and 32k counts above the stored counter,
the decoder temporarily stores the received counter
and waits for a second transmission. The second trans-
mission’s counter is compared to the temporary
counter.  If they are consecutive, the decoder re-syn-
chronizes by storing the latest counter and activates
the appropriate output. Counter values outside of these
windows, 32k – 64k counts above the stored counter
value, are considered invalid and these transmissions
are ignored.

5.1.2 ENCODER ACTIVATION

The encoder is activated when one or more of the
encoder inputs (S0, S1, S2, S3) is pulled HIGH. The
function code (“button code”) is one part of the trans-
mitted code word. The function code mirrors the
encoder inputs and may be used to activate specific
functions of a multifunction decoder. For example, S0
could be used to deactivate the alarm and unlock the
car, S1 to open the trunk and when pressed together
they activate a panic function.

5.1.3 TRANSMISSION BAUD RATES AND 
MODULATION FORMATS

Various modulation formats can be selected for the
encoder data output signal. All KEELOQ encoders offer
a Pulse Width Modulation (PWM) format. In addition,
encoders like the HCS360 and HCS362 offer
Manchester Encoding and the HCS361 and HCS365
offer Variable Pulse Width Modulation (VPWM).

Every encoder offers multiple transmission Baud
Rates; expressed in terms of the an elementary time
element (TE) duration. TE typically ranges from a slow-
est Baud Rate pulse width of 800 µs to a fastest Baud
Rate pulse width of 100 µs. The number of Baud Rate
options and exact values vary with the chosen encoder
model.

5.1.4 OPERATING VOLTAGE

The KEELOQ encoder product line covers a wide range
of operating voltages. Most models operate from 2V to
6V which is ideal for applications using one or two 3V
lithium batteries. Selected models operate directly from
a 9V to  12V battery which is convenient for applica-
tions where a standard 9V battery or a common 12V
(type GP23) battery is used.

5.1.5 LOW VOLTAGE DETECTION

All KEELOQ encoders include a low voltage status bit in
each transmission. The bit is set when the encoder
detects the supply voltage has dropped below a set
threshold. This allows the decoder/receiver to indicate
when the transmitter battery needs replacement. Con-
sult the individual encoder data sheets for the exact
threshold levels available.

5.1.6 COUNTER OVERFLOW

A 16-bit synchronization counter, minimum, is incre-
mented, encrypted, and transmitted each time the
encoder is activated. The 16-bit length of the synchro-
nization counter allows 10 activations per day for 18
years before the cycle begins to repeat. Should the
system designer conclude this is not adequate, then
the overflow bits can be used to extend this cycle. One
of the two overflow bits is cleared each time the counter
wraps 0000. Therefore, utilizing one overflow bit dou-
bles the range of the synchronization counter and uti-
lizing both triples the range of the synchronization
counter.

5.1.7 AUTO-SHUTOFF

An auto-shutoff function is available on KEELOQ encod-
ers. If enabled, the auto-shutoff function stops the
device from transmitting if a button is continuously
pressed for a long period of time. This prevents the
encoder from draining the battery if a button is acciden-
tally pressed while in a pocket or purse. The time-out
period is typically 25 seconds but some devices have
shorter or programmable time-out periods essential for
certification in some countries.
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TABLE 5-1: SUMMARY OF KEELOQ ENCODER DIFFERENCES

Encoder PWM Manchester VPWM 13V
Overflow 

Bits
Function

Inputs
LED

HCS101 X — — X — 3 —

HCS200 X — — X — 3 —

HCS201 X — — X — 3 —

HCS300 X — — — — 3 —

HCS301 X — — X 2 4 X

HCS320 X — — X 2 4 X

HCS360 X X — — 1 4 X

HCS361 X — X — 1 4 X

HCS362 X X — — 2 4 X

HCS365 X X X — 2 4 X

HCS370 X X X — 2 6 X

HCS410 X X — — 2 3 X

HCS412 X X — — 2 3 X

HCS473 X X X — 2 4 X
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6.0 DEMONSTRATION 

TRANSMITTERS

The evaluation kit demonstration transmitters support
any 8- or 14-pin DIP KEELOQ encoder as shown in
Figure 6-1. 

The encoder socket U2 supports 8-pin and 14-pin
encoders inserted with pin 1 in the corresponding pin 1
of the 14-pin socket (Figure 6-1). The demo transmitter
PCB leaves pins 5 through 9 unconnected to accom-
modate the different and sometimes conflicting pin
functionalities on the HCS473, HCS370 and future
products. The user is advised to avoid hand contact
with those pins as there may be only weak internal pull
ups on the most sensitive inputs. Inadvertent input sig-
nals could trigger unexpected responses from the
device confusing the demonstration.

The four buttons (S0..S3) on the demonstration trans-
mitters are connected to the appropriate inputs on the
encoder (S0 through S3). The user may activate any
combination of encoder inputs transmitting any of the
15 possible function codes.  The RFEN output is not
used by the demonstration transmitter and should be
disabled as several encoders share its output with a
button input.  If enabled, a button input may be lost.

The RF oscillator uses a Surface Acoustic Wave
(SAW) resonator to operate at 433.92 MHz. Note that
this is not sufficient to ensure compliance with EC and/
or FCC regulations. 

Jumper JP1 connects the DATA output of the encoder
to the RF transmitter modulator circuit input.  If
removed, it can be used to monitor the digital encoder
output while the RF section is disabled. 

FIGURE 6-1: KEELOQ DEMONSTRATION TRANSMITTER

Programming Connector LED control jumper
RF output jumper

Encoder socket

fits 8- and 14-pin
2 x 3V Lithium battery

LED

pin 1

Demonstration Transmitters

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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The battery holder BT1 accepts one or two CR2016
3V lithium batteries, positive side up. While most
encoder models will demonstrate reliable operation
down to 2V, the demo RF oscillator circuit is only
ensured to operate properly down to 4.5V.

The LED functionality varies with the encoder model
mounted in the transmitter’s socket.  Its connection
changes with the encoder model as well. Jumper JP2
must be set according to the following Table 6-1:

TABLE 6-1:      

The Programming Connector (J1) on the left side of
Figure 6-1 enables the transmitter’s direct connection
to   the    programmer    board    for   In-Circuit   Serial 
Programming™ (ICSP™). Each demo transmitter can
therefore be re-configured without removing the
encoder from the transmitter board. 

Encoder LED
When Flashing 

Indicates
Jumper 2 setting

HCS101 NO — Disconnect

HCS200 NO — Disconnect

HCS201 NO — Disconnect

HCS300 YES Low Battery 1-2

HCS301 YES Low Battery 1-2

HCS320 YES Shift Level 1-2

HCS360 YES Low Battery 1-2

HCS361 YES Low Battery 1-2

HCS362 YES Low Battery 1-2

HCS365 YES Once = Low Battery 2-3

HCS370 YES Once = Low Battery 2-3

HCS410 NO — Disconnect

HCS412 YES Once = Low Battery 1-2

HCS473 YES Once = Low Battery 2-3

Note: Although the kit’s included Demonstra-
tion Transmitters connect multiple lines
(up to 8 out of 16 available) to the Pro-
gramming Connector, only four lines are
typically required for production In-Circuit
Serial Programming (ICSP).
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7.0 THE MAIN BOARD 

The following chapters examine the main board by
dividing it into areas of specific functionalities (see
Figure 7-1):

• Radio Receiver
• Demo Decoders
• Main Processor

• Serial Interface
• Programming Socket
• Transponder Interface

• Power Supply
• Step Up Circuit
• Prototyping Area   

FIGURE 7-1:  THE MAIN BOARD   

Power Supply Radio Receiver
Transponder Interface

Main Processor

Serial Interface

Prototyping Area

Step Up Circuit

Demo Decoders Programming
Socket

The Main Board

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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7.1 Radio Receiver

The Demo Board contains an ASK Radio Receiver
module that serves the Decoders as well as the Main
Processor.

The module is a standard thick-film hybrid circuit mod-
ule tuned by the manufacturer to 433.92 MHz. The
demodulated digital output signal may be directly fed
into any microcontroller I/O pin. 

This type of radio receiver module is common, low cost
and recommended to those without RF design capabil-
ities. The pin-out is standard. Thus, it may be easily
replaced with similar models accommodating various
frequencies, sensitivity levels, modulation methods
(ASK vs. FSK) as well as complying to various interna-
tional certification standards.

FIGURE 7-2: THE RADIO RECEIVER    

Jumper JP1 allows the radio receiver output to be dis-
connected from the decoders. This permits monitoring
the receiver output on an oscilloscope or injecting an
encoder’s digital output directly into the decoder

7.2 Demonstration Decoders   

The Decoder area is subdivided into three sections:

1. Software Decoders 
2. HCS512 Decoder

3. HCS515 Decoder

Each section has a Learn button, an RC oscillator cir-
cuit and a set of LEDs to show the Decoder’s output
status but they share the radio receiver output at JP1.

A non-volatile memory is available to the software
decoders; 93C46 EEPROM, socket U3.  Voltage super-
vising (Brown out Reset) circuitry and power supply are
common with the Main Processor.

The HCS512 and HCS515 decoders are connected to
the Main Processor with separate pairs of clock and
data lines such that they may be independently config-
ured.  Although the current firmware release does not
support it, the decoder coprocessor functionality could
be demonstrated.

Radio Receiver
Jumper JP1 
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FIGURE 7-3: THE THREE DECODERS    

7.2.1 SOFTWARE DECODERS

Three basic Software Decoders may be demonstrated
in this portion of the board:

1. SIMPLE Learn Decoder 
(AN659_Confidential/AN663_Non Restricted)

2. NORMAL Learn Decoder 
(AN642_Confidential/AN661_Non Restricted)

3. SECURE Learn Decoder 
(AN652_Confidential/AN662_Non Restricted) 

The decoder functionalities are described in the related
Application Notes. Both the Non-Restricted and Confi-
dential versions describe the functionality and method-
ologies for the different Learning Schemes.  The
Confidential version further explains the decryption and
adds the full source code.

An official introduction to KEELOQ and its different
Learning Schemes can be found in either the Applica-
tion Notes or Technical Briefs TB001 and TB003. In
short: 

1. The SIMPLE Learn Decoder uses a single 
common key for all encoders. Such a key is
hard-coded in the decoder’s firmware. The
Learning phase  requires only a single encoder
transmission for the decoder to memorize the
encoder’s unique Serial Number and Synchroni-
zation Information. The values are stored in the
non-volatile memory.

2. The NORMAL Learn Decoder generates a 
different key for every encoder. The encoder
Serial Number is one input to the Key 
Generation algorithm which is in fact the 
Decrypt algorithm. Learning requires two con-
secutive Hopping Code transmissions. 

3. The SECURE Learn Decoder uses a random
Seed value transmitted by the encoder and
either the XOR algorithm or the Decryption 
algorithm (selectable in the application note
source code) as the Key Generation algorithm. 

The Manufacturer’s Key for the Software Decoder sam-
ples is by default set to  0123456789ABCDEF16. 

Since the software decoders are  based on OTP micro-
controllers (PIC16C54 and PIC16C56) they cannot be
configured by the Evaluation Kit software.

Software 

Decoders

HCS512 
Decoder

HCS515
Decoder
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FIGURE 7-4: WARNING RECEIVED WHEN TRYING TO CONFIGURE A DECODER  

7.2.2 HCS512 DECODER

The HCS512 is a fully integrated KEELOQ decoder
since it contains the necessary non-volatile memory to
store the Serial Number and Synchronization Informa-
tion for up to four transmitters. 

The HCS512 can be used either as a stand-alone
decoder, connecting the S0:S3 outputs directly to sys-
tem outputs, or used in “co-processor mode” in con-
junction with a microcontroller when the CLOCK and
DATA synchronous communication lines are used.

A Sleep Mode is available for low power applications.

The HCS512 decoder can be configured by the Evalu-
ation Kit software to perform Normal Learn or Secure
Learn operation using XOR or Decrypt Algorithm as the
Key Generation algorithm.

FIGURE 7-5: THE HCS512 CONFIGURATION DIALOG BOX.   

In the dialog box above the user can:

•  assign text as a title or description of the decoder.  
The entry will be recorded in the project configura-
tion file for documentation purposes.

• change the Manufacturer Code used for the Key 
Generation process during Learning

• select the desired learning scheme among:

- Normal Learn

- Secure Learn - XOR 
- Secure Learn - Decrypt

• enable the Sleep feature to reduce power con-
sumption when there is no signal coming from the 
radio.    
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7.2.3 HCS515 DECODER

The HCS515 is a low cost integrated  KEELOQ decoder
in a convenient 14-pin package. 

The decoder contains non-volatile memory (EEPROM)
to store the Serial Number and Synchronization Infor-
mation of up to seven transmitters.  There is also an
additional 1 Kbit of User storage space. 

The HCS515 can be used in “stand-alone mode”, con-
necting the S0:S1 outputs directly to system outputs, or
used in “co-processor mode” in conjunction with a
microcontroller when the CLOCK and DATA synchro-
nous communication lines are used.

The HCS515 decoder can be configured by the Evalu-
ation Kit software to perform Normal Learn or Secure
Learn operation using the Decrypt Algorithm as the Key
Generation algorithm.

FIGURE 7-6: THE HCS515 CONFIGURATION DIALOG BOX.   

In this dialog box the user can:

•  assign text as a title or description of the decoder.  
The entry will be recorded in the project configura-
tion file for documentation purposes.

• change the Manufacturer Code used for the Key 
Generation process during Learning

• select the desired learning scheme among:
- Normal Learn

- Secure Learn - Decrypt
• enable the Repeat feature. Repeat instructs the 

decoder to maintain the outputs active as long as 
the user presses an encoder button. 

7.3 Demo Decoders Outputs

S0:S3 – The outputs mirror the buttons pressed on a
learned transmitter.

LEARN OUT – The learn output gives the user feed-
back during a learn sequence. During normal operation
the LEARN LED flashes briefly whenever a KEELOQ

transmission is received.

FUNC OK – The FUNC OK output is activated when
the received function code matches the function code
received when the decoder was learned

VLOW – The output is activated when the VLOW bit is
set in a transmission. A KEELOQ encoder sets this bit
when the battery supply voltage drops below the prede-
termined threshold.

    
TABLE 7-1: DECODER SUMMARY

Decoder S0:S3 Learn FUNC OK VLOW
Maximum

Transmitters

SIMPLE X X — — 15

NORMAL X X X — 6

SECURE X X X — 6

HCS512 X X — X 4

HCS515 S0:S1 X — — 7   
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7.4 Learning New Transmitters 

All KEELOQ decoders support transmitter learning; add-
ing new transmitters to the system without the need to
reprogram the system. During the learning process, the
decoder identifies the transmitter and stores its param-
eters (key and synchronization information) in non-vol-
atile memory for future use. After learning, the decoder
will recognize the transmitter and respond to it nor-
mally.

The decoder’s learning capability also simplifies the
replacement of lost transmitters. When a transmitter is
lost, the user can “teach” the decoder the key of the
replacement transmitter. Different decoders have dif-
ferent  capacities in terms of maximum number of
transmitters that can be learned (see Table 7-1). 

When a transmitter is lost, it is advisable to erase the
memory and re-learn the existing transmitters. This will
deny the lost transmitter access to the system.

Learning a transmitter is a two-phase process. During
the learn process a key is generated by the decoder.
The key is stored with the transmitter’s serial number
and synchronization information after the key has been
verified.

The key generation process has three inputs. The first
is the source of the key generation. The source can be
the encoder’s serial number (normal learn) or the
encoder’s seed (secure learn). The second input is the
key generation algorithm; the decryption algorithm or
the XOR algorithm. The third input to the system is a
manufacturer’s key. The manufacturer’s key tailors the
key generation algorithm to a specific manufacturer.
Customizing the key generation algorithm means com-
petitors cannot clone another manufacturer’s transmit-
ters.

With the exception of the Simple Decoder, two trans-
missions are needed by the decoder during learn: one
to generate a key and the second to validate the key. If
the key generation source is the serial number then
both transmissions will be normal Code Hopping trans-
missions. If the user chooses secure learn (Seed value
as the key generation source) the first transmission
should be a Code Hopping transmission and the sec-
ond transmission a “Seed transmission”. Seed trans-
missions are obtained by pressing a special
combination of buttons. In the case of the HCS300, a
seed transmission is activated by simultaneously
pressing all four buttons S0 – S3. 

The Evaluation Kit II software and PRO MATE II soft-
ware (Microchip Universal Programmer)  have been
designed so that the Encoder Key Generation phase is
transparent to the user.

7.4.1 LEARNING PROCEDURE STEP BY 
STEP

Learning a transmitter on the NORMAL,SECURE soft-
ware decoders and HCS512 decoders is accomplished
as follows:

1. Press and release the decoder’s LEARN button.
The LEARN OUT LED will turn on to indicate
that the decoder has entered Learn mode.

2. Press a transmitter button. The LEARN LED will
turn off, indicating a transmission has been
received.

3. Press a transmitter button a second time. The
LEARN LED will flash several times to indicate
that the transmitter was learned successfully

4. The learning attempt will fail if the transmitter is
not configured to operate in the same Learn
Scheme as the decoder, the Manufacturer Code
is different, two non-sequential codes are
received, two acceptable codes are not received
within 30 seconds, or simply if the radio trans-
mission was corrupted by noise. The decoder
indicates a failed learn by making the LED flash
briefly once.  Try again starting from step 1.  
If Learning fails again, the user is recommended
to verify the Manufacturer’s Code and Learning
Scheme of the encoder and decoder match. 

5. If step 3 succeeded, repeat steps 1-3 to learn up
to the maximum number of transmitters.

7.4.2 LEARNING ON A SIMPLE 
DECODER STEP BY STEP

In SIMPLE Learn all encoders and decoders share a
common key that coincides with the Manufacturer’s
Code. As a consequence, the system security is dimin-
ished but the decoder code to implement it is shorter.
The learn procedure flows as follows:

1. Press and release the LEARN button. The
LEARN OUT LED will turn on while the button is
pressed and turn off when the button is
released.

2. Press any transmitter button. 

3. The LEARN OUT LED will turn on for a second
if the Learn is successful. If the transmission is
not acceptable the decoder will return to normal
operation. Unacceptable transmissions result if
the encoder is configured with a different Manu-
facturer’s Code or a transmission is not received
within 30 seconds 

Note: The second transmission must be a
SEED transmission when secure learn
is used.
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7.4.3 LEARNING ON AN HCS515 
DECODER STEP BY STEP

1. Press and hold the LEARN button until the
LEARN OUT LED first turns on and then off
about a second later. 

2. Press any transmitter button. 
3. The LEARN OUT LED will flash briefly.
4. Press any transmitter button if configured 

for NORMAL Learn or the SEED button 
combination if configured for SECURE Learn.

5. The LEARN OUT LED will flash for a second
time.

6. Press the transmitter again to determine if the
Learning attempt was successful. The LEARN
OUT LED will flash only if the transmitter was
successfully learned.

7.4.4 TRANSMITTER ERASING ON 
HCS512 AND SOFTWARE 
DECODERS

Erasing all the learned transmitters from memory is
accomplished by pressing and holding the LEARN but-
ton for 8 seconds. The LED will turn off at the end of the
8 seconds to indicate that the non-volatile memory has
been erased.

7.4.5 TRANSMITTER ERASING ON 
HCS515 DECODER

Press and hold the LEARN button. It will turn on for
about a second and then off again. Continue holding for
about 10 seconds until the LED turns on again. Only
then release the LEARN button. The LED will finally
turn off to indicate that the non-volatile memory has
been erased.

7.5 The Main Processor

The main processor area contains a TQFP PIC16F877
operating with a 20 MHz crystal clock (HS mode).

The microprocessor’s internal brown out circuit is dis-
abled as an external Microchip voltage supervisor
device MCP120 – 450 is used. The voltage supervisor
provides reset to both the PICmicro MCU and the
decoders when the supply drops below 4.5V; except
the HCS512 decoder, see below.  4.5V is the minimum
operating voltage of the PICmicro MCU when operating
at 20MHz. 

The PCB area surrounding the PICmicro microcontrol-
ler provides easy access to the PICmicro MCU’s I/O’s
through about 40 pads/vias. The access points are
available for testing or connecting to the prototype
area.

Two button switches are available: RESET and BOOT.
The BOOT button is connected to the RB4 I/O pin as
well as to the HCS512 decoder’s separate reset line.

The BOOT button is used by the BOOT loader to down-
load new firmware into the Main Processor from the
Serial Port and bootstrap it into execution.

FIGURE 7-7: THE MAIN PROCESSOR AREA   

PIC16F877

BOOT 

I/O pads/vias

ICSP/ICD

connectors

Socket for 24LCXX

20 MHz

Reset 

Crystal

LCD display connector
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A socket (U5) for an additional external I2C™
EEPROM (24LCXX) is provided for future expansion
as well as a standard 14-pin LCD display connector
(J6).

An   In-Circuit Debugger  compatible   connector   J4 
(RJ11 type) can be mounted below the two buttons to
allow connection with the standard Microchip Flash
ICD Development Tool.

7.5.1 THE SERIAL INTERFACE

A DB9 RS-232 serial interface connector is located on
the left side of the board. Four I/O lines connect the
Main Processor to the serial port. The RX and TX sig-
nals connect directly to the RC6 and RC7 UART pins
on the PICmicro MCU. The RTS and CTS hardware
handshake signals connect to the PICmicro microcon-
troller although the initial software release does not
make use of them.

A Microchip TC232C driver chip, or compatible, per-
forms full translation of the I/O levels to comply to RS-
232C specifications.

FIGURE 7-8: THE SERIAL INTERFACE    

7.5.2 POWER SUPPLY AND 
PROTOTYPING AREA

The power supply circuit is designed to regulate a max-
imum current of 100 mA at 5V from two possible
sources:

• An external 9V battery, useful for demonstrations 
and ease of transport, 

• A power supply unit capable of providing an 
unregulated 9V – 15V.

An internal diode bridge allows the use of AC or DC
external power supply units; connector polarity is irrel-
evant.

A diode in the 9V battery circuit protects the board from
accidental reverse battery connections.

The Red and Black terminals in the Prototyping area
provide convenient +5V and GND connections, respec-
tively, to the custom circuitry.

The user must guarantee that the Prototype area cus-
tom circuit current draw added to the Main Board con-
sumption (varying with the number of decoders
mounted and their use) does not exceed the 100 mA
total limit.

RS-232 connector

RS-232 driver
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FIGURE 7-9: THE POWER SUPPLY AND PROTOTYPING AREA

7.5.3 THE TRANSPONDER INTERFACE

The transponder interface is left unpopulated by
default.  It is provided for future expansion only and is
not supported in the initial firmware release.

The interface circuit requires a reader coil of appropri-
ate inductance connected to JP2. Capacitors C2, C3,
and C4 are used to tune the resulting resonant circuit
frequency; typically to 125 kHz.

The PIC16F877’s second internal PWM module can
directly control the carrier signal (pin RC1), while a fil-
tered and amplified Read signal is received on the
standard RE1 I/O pin. A Write signal (pin RB0), can
also control the resonant circuit through a MOSFET
driver.

FIGURE 7-10:  THE TRANSPONDER INTERFACE CIRCUIT  
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7.5.4 THE PROGRAMMING SOCKET, 
CONNECTOR AND STEP UP 
CIRCUIT

The step up circuit, controlled by the Main Processor
PWM module, boosts the +5V main power supply to a
programming voltage (VPP) of up to 12.5V. The higher
voltage is used to program some encoder models such
as the HCS365, HCS370 and HCS473. 

FIGURE 7-11: THE PROGRAMMING SOCKET AND STEP UP CIRCUIT

The Evaluation Kit provides two methods of program-
ming the encoders:

• In-Socket allows programming and serialization of 
DIP samples before they are mounted on the 
demo transmitters.

• In-Circuit programs the encoders directly on the 
Demo Transmitter board.

When programming In-Socket, the user will always
align the part to the top; pin 1 of the encoder into pin 1
of the socket.

The socket only allows the insertion of encoder DIP
samples in 8-, 14- and 20-pin packages. The 20-pin
capability provides for future compatibility. Special third
party adaptors may be purchased converting the DIP
interface to another desired package.

The Evaluation Kit is designed to be a teaching and
prototyping tool.  It is not designed to be a production
programmer and therefore is not capable of performing
more than a few programming sessions per day. 

The user is encouraged to use the PRO MATE II Micro-
chip Universal Programmer and the appropriate inter-
changeable programming sockets when programming
quantities of devices.  The interchangeable program-
ming sockets support the DIP, SOIC, TSSOP packages
and In-Circuit Serial Programming, as necessary.

The Eval Kit’s In-Circuit Programming is restricted to
the Demonstration Transmitters included in the kit.

The Transmitter’s Programming Connector, Figure 7-
12, provides connection to the Main Board.

Step Up

Programming

Socket
Program LED

circuit

Transmitters.

Programming Connector
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FIGURE 7-12: IN-CIRCUIT PROGRAMMING OF A DEMO TRANSMITTER 
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FIGURE A-1: ENCODER SCHEMATIC

Appendix A:  Schematic Diagrams

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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FIGURE A-2: MAIN BOARD SCHEMATIC  
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FIGURE A-3: KEELOQ DECODER SCHEMATIC
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FIGURE A-4: TRANSPONDER READER & STEP UP CIRCUIT
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The KEELOQ Evaluation Kit can be used to In-Circuit
program most prototype encoders and all of the decod-
ers. 

When performing In-Circuit Programming, verify that
the Encoder Programming Socket and Demo Decod-
ers Sockets are empty! 

The following sections will provide a detailed descrip-
tion of the required connections between the J3 con-
nector and the various encoders and decoders models.

FIGURE B-1: PINOUTS OF J3 TRANSMITTER PROGRAMMING CONNECTOR 

 B.1 HCS101/HCS200/HCS201 
HCS300/HCS301/HCS320 ICSP 
Connection

These devices can be programmed In-Circuit using the
Demo Transmitter (directly inserted in connector J6) or
by providing custom In-Circuit connections as
described in the following table:

TABLE B-1: HCS101/HCS200/HCS201/HCS300/HCS301/HCS320 ICSP   

15 16

1 2
TX_232

RX_232

515_DATA

515_CLK

512_CLK

+5V

RFIN

512_DAT

GND

DATA

NC

S2

Prog. VPP

S0

Prog. VDD

S1

J3 Pin Description Encoder Pin Description

1 GND 5 GND

11 CLOCK 3 S2

3 DATA 6 DATA

14 Prog. VDD 8 VDD

Appendix B:  In-Circuit Programming

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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 B.2 HCS360/HCS361 ICSP Connection

These devices can be programmed In-Circuit using the
Demo Transmitter (directly inserted in connector J6) or
by providing custom In-Circuit connections as
described in the following table:

TABLE B-2:  HCS360/HCS361 ICSP    

 B.3 HCS362/HCS410/HCS412 ICSP 
Connection

These devices can be programmed In-Circuit using the
Demo Transmitter (directly inserted in connector J6) or
by providing custom In-Circuit connections as
described in the following table:

TABLE B-3: HCS362/HCS410/HCS412 ICSP   

 B.4 HCS365/HCS370/HCS473 ICSP 
Connection 

These devices can not be programmed In-Circuit
using the Demo Transmitter.

J3 Pin Description Encoder Pin Description

1 GND 5 GND

11 CLOCK 3 S2

13 S1 2 S1

3 DATA 6 DATA

14 Prog. VDD 8 VDD

J3 Pin Description Encoder Pin Description

1 GND 5 GND

11 CLOCK 3 S2

3 DATA 6 DATA

14 Prog. VDD 8 VDD
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In-Circuit Programming is possible only providing con-
nections to a target transmitter as described in the fol-
lowing table:

TABLE B-4: HCS365/HCS370/HCS473 ICSP   

 B.5 HCS500 ICSP Connection

The HCS500 decoder can be Programmed In-Circuit
using the connections described in the following table:

TABLE B-5:  HCS500 ICSP   

The HCS500 must be connected to the companion
24LC01 (or 24LC02) memory and both parts must be
powered.

J3 Pin Description Encoder Pin Description

1 GND 5 GND

15 S0(DATA) 1 S0

13 S1(CLOCK) 2 S1

5 Prog. VPP 7(13)* VPP

14 Prog. VDD 8(14)* VDD

Note: Encoder Pins in parenthesis are
related to the 14-pin packages
(HCS370 and HCS473).

J3 Pin Description Decoder Pin Description

1 GND 5 GND

8 CLK_515 6 CLOCK

6 DAT_515 5 DATA

Note: Refer to Appendix C for a description
of the modifications required to the
Main Board to provide direct support
for this decoder.
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 B.6 HCS512 ICSP Connection 

The HCS515 decoder can be Programmed In-Circuit
using the connections described in the following table:

TABLE B-6:  HCS512 ICSP  

The HCS512 decoder target board must be powered
(VDD = 5V) and the target oscillator circuit must be run-
ning at 4 MHz (verify pin 15 output = square wave @ 1
MHz).

 B.7 HCS515 ICSP Connection 

The HCS515 decoder can be Programmed In-
Circuit using the connections described in the 
following table:

TABLE B-7:  HCS500 ICSP    

The HCS515 decoder target board must be powered
up (VDD = 5V)

J3 Pin Description Decoder Pin Description

1 GND 5 GND

12 CLK_512 12 CLOCK

10 DAT_512 13 DATA

RB4* MCLR_512 4 MCLR

Note: Pin RB4 is only accessible through the
prototyping pads around the main pro-
cessor in this revision of the Evaluation
Kit II board (01584 rev. B).

J3 Pin Description Decoder Pin Description

1 GND 12 GND

8 CLK_515 10 CLOCK

6 DAT_515 9 DATA
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It is possible to modify the Evaluation Kit II Main Board
to directly support and demonstrate the HCS500
decoder functionality. Following the next few simple
steps the HCS515 demonstration/programming socket
will be modified to host an HCS500 decoder and its
companion 24LC02 memory.

FIGURE C-1:  THE HCS515 DEMONSTRATION SOCKET  

Step 1. Remove the 14-pin DIP socket. Be
extremely careful not to break any PCB
connection.

Step 2. Insert two 8-pin DIP sockets starting from
pin 1 (squared) on the left and leaving the
last row empty as illustrated in .

HCS515 socket

Appendix C:  HCS500 Support

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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FIGURE C-2: INSERTING THE HCS500 SOCKET   

Step 3. Remove R64 and R66 (1 KΩ SMD 
resistors).

Step 4. Insert R65 (4.7 KΩ SMD resistor).

  

FIGURE C-3: RESISTORS R64, R65, R66 POSITION 

HCS515
socket

HCS500+NVM
socket

pin 1 pin 1

pin 1

24LC01/02 HCS500

NC 

HCS515

Note: After the modifications, the LEARN
OUT LED assumes the functionality of
the HCS500 decoder’s single output.
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D.1 Connectors Layout

FIGURE D-1: CONNECTORS AND TEST POINTS LAYOUT 

D.1.1 J1- POWER SUPPLY

Power Supply, 9V – 15V input.

AC/DC input, (NO polarity)

D.1.2 BT1- BATTERY CLIP

9V battery clip

Polarity is dictated by the clip mechanics.

A diode (CR2) protects from reversed polarity insertion
and inverse currents should the power supply be used
at the same time.

D.1.3 TEST POINTS ON PROTOTYPING 
AREA

Red +5V TP and corresponding Black GND TP

Provides regulated 5V output for proto area.

The voltage regulator (VR1) is capable of 100 mA  max.
The current draw of the prototype area must be limited
to keep total board consumption (varying with the num-
ber 100 mA limit.

D.1.4 J2- RS-232 (9-PIN)

  

Hardware handshake is not used in revision (v.3.00.00)
of the firmware

BT1- battery clip JP2-transponder coil J6-LCD

+5V
GNDJ3-TX prog.

J2-RS-232

J1-power 

Programming J4-ICD

J5-ICSP

Socket

supply

Pin Signal MCU pin

1 NC —

2 TX RC6

3 RX RC7

4 NC —

5 GND VSS

6 NC —

7 CTS RC5

8 RTS RC0

9 NC —

Appendix D:  Connectors

KEELOQ® EVALUATION KIT
II USER’S GUIDE
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D.1.5 J3- TX PROGRAM CONNECTOR 

    

D.1.6 J4- ICD (RJ11 TYPE)

 

D.1.7 J5- ICSP (6 POLES IN LINE)

 

Pin Signal MCU pin Pin Signal MCU pin

1 GND Vss 2 TX_232 RC6

3 DATA RA5 4 RX_232 RC7

5 VPP — 6 515_DATA RE2

7 NC — 8 515_CLK RA3

9 LED0/Vdd RD7 10 512_DAT RA2

11 S2 RB2 12 512_CLK RA1

13 S1 RB1 14 +5V VDD

15 S0 RB0 16 RFIN RE0

Pin Signal MCU pin

1 MCLR MCLR

2 +5V VDD

3 GND VSS

4 DAT_ICSP RB7

5 CLK_ICSP RB6

6 VPP RB3

Pin Signal MCU pin

1 MCLR MCLR

2 +5V VDD

3 GND VSS

4 DAT_ICSP RB7

5 CLK_ICSP RB6

6 VPP RB3
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D.1.8 SOC1- PROGRAMMING SOCKET

   

D.2 Future Expansion

D.2.1 J6- LCD DISPLAY

    

This connector allows for control of the LCD in “4-bit
Upper Nibble Mode”

D.2.2 JP2- TRANSPONDER COIL 

Provides for the connection of a transponder reader
coil.

The inductance of the coil has to match the capacitance
value of C2 + C3 + C4 for resonance at 125 kHz. 

Other frequencies can be obtained by changing the
PWM output frequency of the PIC16F877, but will
require also the optimization of the input filter.

Pin Signal MCU pin Pin Signal MCU pin

1 S0 RB0 11 Prog. VDD RD7

2 S1 RB1 12 VPP —

3 S2 RB2 13 DATA RA5

4 S3 RB3 14 GND VSS

5 — — 15 — —

6 — — 16 — —

7 — — 17 — —

8 — — 18 — —

9 —- — 19 — —

10 — — 20 — —

Pin Signal MCU pin

1 GND Vss

2 +5V Vdd

3 V0 contrast —

4 RS RD5

5 RW RD4

6 E RD6

7 DB0 NC

8 DB1 NC

9 DB2 NC

10 DB3 NC

11 DB4 RD0

12 DB5 RD1

13 DB6 RD2

14 DB7 RD3
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NOTES:
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NOTES:
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